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ASCENDER - Position Management: Update
NYR Positions and Move Employees to CYR
Payroll

This guide provides the necessary steps to update next year positions and move 12-, 11-, and
10-month employees to the current year payroll.

This guide assumes you are familiar with the basic features of the ASCENDER Business system
and have reviewed the ASCENDER Business Overview guide.

12-month Employees

This process moves employees who receive their first paycheck in July from next year Position
Management to current year Position Management. It also updates some of the fields on the
following Maintenance tabs in the current year (see step 7 for detailed information):

Employment Info
Pay Info
Job Info
Distributions

A separate simulation needs to be set up for employees who receive their first paycheck in July.
This is necessary because the position in the next year Position Management reflects the current
year’s salary information. The simulation updates the fields in the next year positions for the new
school year and clears the Accept Changes field. The new salary information from the next year
position is updated in the current year, updating both the current year Position Management and
the Staff Job/Pay Data fields for those employees. As 12-month employees do not accrue, it is not
necessary to move them to the next year payroll. Contact your regional ESC consultant to discuss
moving 12-month employees to the next year payroll.

Note: Depending on the LEA, it may not be necessary to set up separate simulations. If the LEA
has determined next year salaries and completed all interfacing to Budget for the year, one
simulation can be used when moving employees. Contact your regional ESC consultant to discuss
this option.

It is important to consider how this process affects the budget. If you update 12-month positions
with the new salary amount for the next school year in the next year Position Management,
running the simulation a second time at a later date for all employees gives the 12-month
employees an additional increase. If you were unable to update the budget with accurate salaries
for all employees prior to rolling 12-month employees, it is necessary to update Budget with
multiple simulations. Reference the Interface to Budget Checklist.

The following checklist assumes the LEA has interfaced the payroll salaries to Budget using the

https://help.ascendertx.com/test/business/doku.php/academy/business_overview_guide
https://help.ascendertx.com/test/business/doku.php/academy/pmis_interface_to_budget_checklist
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Salary Simulation process in Position Management.

TIP: Be sure to complete service records and extract June TRS before continuing this
process. This process updates the begin and end contract dates for 12-month employees
in the current year payroll. Service records must reflect the begin and end dates from
the current school year, and these dates are used to calculate the days and hours
worked for TRS purposes. This process will overwrite the employee’s calendar with the
calendar for the new year. If June TRS has not been extracted, the system is unable to
calculate this information for June.

Verify account code fiscal years.1.

Position Management > Utilities > Update Fiscal Year by Fund

Verify that the account code fiscal years are accurate. This tab provides a list of the fund/fiscal
years that are set up in the positions. This process increments the position distribution fiscal
year by 1.

Note: Since the account codes are validated against the budget, there should not be any
fiscal years less than the next year. If there are, generate a user-created report to identify
the positions and manually update the information.

Generate a user-created report.2.

Position Management > Reports > User Created Reports > CYR/NYR Positions

Generate a PMIS user-created report to verify that the Increase Eligible field is selected for
applicable positions. It is possible that the field is not selected for new LEA employees from last
year.

❏ It is recommended to verify the Nbr Remain Payments field prior to calculating salaries.

❏ Select the following fields on the user-created report:

https://help.ascendertx.com/test/business/doku.php/positionmanagement/utilities/updatefiscalyearbyfund
https://help.ascendertx.com/test/business/doku.php/positionmanagement/reports/usercreatedreports/cyrnyrpositions
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❏ Click Create Report. The report is displayed. Use the sort/filter functionality to group the
applicable data.

Note: The number of remaining payments reflected on the report is displayed on the Job
Info tab as the number of annual payments and the number of remaining payments for the
employee for any P position type. If the LEA uses S acct types or business allowances for
extra duties, S position types on this report should reflect the correct number of remaining
payments. Prior to continuing, make the necessary position corrections.

Verify retiree information.3.

Position Management > Maintenance > PMIS Position Modify > Budget

Verify that the TRS Status field is set to 5 - Retired for retirees. If the TRS status is incorrect,
there is a possibility that the status will be incorrect (TRS-eligible) when the employee is moved
to the current year payroll.

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/setup_processing_newusers_usercreatedreport.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
https://help.ascendertx.com/test/business/doku.php/positionmanagement/maintenance/pmispositionmodify/positionrecord
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Identify employees to be moved to current year payroll.4.

Log on to the current year.

Payroll > Reports > User Created Reports

Generate a user-created report to identify the employees who begin their new contract in July. It
is possible that the employees are inactive in the current year, be sure that the Active
Employees Only field is not selected.

❏ Prepare a list of new hires as a supplement to this list. Sort by the Payoff Date to verify that
all employees who have a June payoff date have the same date. For example, it is possible that
an employee has a payoff date that is a day before or after the actual June payoff date.

❏ Generate a user-created report again to verify that all of the data is accurate. Filter the report
using your LEA's June payoff date (YYYYMMDD).

https://help.ascendertx.com/test/business/doku.php/payroll/reports/usercreatedreports
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_usercreatedreport.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
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Print or save the report.

Create a salary simulation.5.

Log on to the next year.

Prior to setting up and performing salary simulations, review the Position Management:
Salary Simulations Overview guide for a description of the Salary Simulation pages and
samples of the available simulation reports.

Position Management > Utilities > Salary Simulation > Simulation Options

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/12_month_june_payoff_date.png?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
https://help.ascendertx.com/test/business/doku.php/academy/business_positionmanagement_salarysimulations
https://help.ascendertx.com/test/business/doku.php/academy/business_positionmanagement_salarysimulations
https://help.ascendertx.com/test/business/doku.php/positionmanagement/utilities/salarysimulation/simulationoptions
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❏ Complete the following:

(Recommended) In the Include Vacant Supplement Positions field, select No.
In the Update Forecast field, select No.
In the Update Budget field, select N - Do Not Update Budget.
Include all first pay date codes for 12-month employees who receive their first paycheck
in July. Include all local/annual, hourly/daily, midpoint (if applicable), and extra duty
tables.
If increases are not provided to 12-month employees in July, do not include an increase in
the salary tables. If increases are provided to 12-month employees in July, update the
salary tables with the increase data.
If the LEA decides to interface the simulation to Budget, add the deductions with the
annual amount for the Employer Contribution.

❏ Click Save.

❏ Click Execute. Review the Simulation Process Error Listing and correct any errors prior to
continuing the process.

Generate the simulation reports and review all salaries.
Review the user-created report to confirm that all 12-month employees or positions are
included in the simulation. The reflected salaries are the amounts that are used to pay
employees in the current year payroll.

If necessary, continue making corrections and running the simulation until all of the salary
amounts are correct.

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_salarysimulation12moemployee.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
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❏ Run the final simulation. This process updates the included state step, pay step, and salary
amount in the next year PMIS for all 12-month positions and clears the Accept Changes field.

In the Update Forecast field, select Yes.
Click Save.
Generate and save the reports.
Click Process to process the simulation. Create a backup.

Copy school calendars from next year to current year payroll.6.

Log on to the next year.

Payroll > Next Year > Copy Next Year Tables

❏ In the School Calendar field, select only the 12-month employee calendars.

TIP: The calendar code is displayed in the first pay date code on the simulation
(e.g., J40 includes calendar code 40).

❏ Click Execute.

Note: If changes were made to the next year payroll tables (extra duty pay, hourly/daily
salary, job code, local annual salary, etc.), copy the tables from the next year payroll to the
current year payroll.

Generate a user-created report.7.

https://help.ascendertx.com/test/business/doku.php/general/pmis_backup
https://help.ascendertx.com/test/business/doku.php/payroll/nextyear/copynyrtablestocyr
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_copynyrtablestocyr.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
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Log on to the current year.

Payroll > Reports > User Created Reports

Generate a user-created report with the Hrs Per Day field selected. This field is overwritten
when positions are moved from the next year to the current year.

Move forecast to current year position and payroll8.

Log on to the next year.

Position Management > Utilities > Move Forecast to CYR Position and Payroll

This process is used to move payroll and position forecast records to the current year PMIS with
the same information that is set up in the next year PMIS records.

It also updates fields on the following Maintenance tabs: Employment Info, Pay Info, Job Info,
Distribution

The Accept Changes field must be cleared when moving position records from forecast to
current; otherwise, position records cannot be moved. The Accept Changes field is cleared
after running a simulation with the Update Forecast field set to Yes. Similarly, you cannot run
a simulation for positions without the Accept Changes field selected.

https://help.ascendertx.com/test/business/doku.php/payroll/reports/usercreatedreports
https://help.ascendertx.com/test/business/doku.php/positionmanagement/utilities/moveforecasttocyrpositionandpayroll
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_moveforecasttocyrpositionandpayroll.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
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Select Pay Frequency Click  to select the pay frequency where you want to move
to the current year. This is a required field.

Include Vacant Supplements Select to include the vacant supplement positions.

Recommendation: Do not select this field unless it is your
final move.

Validate Accounts against
General Ledger

This field is selected by default. Clear this field to not validate
the accounts against the general ledger.

Recommendation: Select this field if you are doing your first
test move. By doing so, the appropriate errors are generated
to inform you of incorrect account codes in PMIS. If not
selected, those account codes are moved to Payroll if each
account component is valid.

Update TRS Year Flag Select to update the TRS Year field on the Payroll > Staff/Job
Pay Data > Job Info tab.

Recommendation: Select this field if the employees being
moved will receive a contract payment prior to the first pay
date of the new school year (i.e., July and August starts).

Update Workers' Comp
Annual and Remaining
Payments

Select to update the WC Ann Pymts and WC Remain fields
on the Payroll > Staff/Job Pay Data > Job Info tab.

The WC Ann Pymts field indicates the number of annual
workers' compensation payments for the contract period and
the WC Remain field indicates the number of remaining
workers' compensation payments to be made during the
contract period.

Add Additional Workers'
Comp Payments

Type the number of additional workers' compensation
payments. The field accepts any value between 0-9.

This field is helpful as it can be difficult to identify which
months have a third payroll for the biweekly frequency. You
can use this field to add one or two to the contract months
times two.

Select State Minimum Salary
Table (CYR/NYR)

Click  to select the current year or next year. This is a
required field.

This selection determines which salary table is referenced
when calculating the state foundation salary.

Select First Pay Date Codes
or blank for ALL

Select the first pay date codes that begin their new contract
payout. Type the pay date codes, separating multiple pay
date codes with a comma but no space (e.g., 1,17,88,A1). Or,
click  to search for pay date codes. Otherwise, leave blank
to use all pay date codes.

Include Extra Duty Select to include extra duty in the process. If not selected, no
extra duty will be processed even if extra duty codes are
selected.

https://help.ascendertx.com/test/business/lib/exe/detail.php/images/dropdown.gif?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
https://help.ascendertx.com/test/business/lib/exe/detail.php/images/picklist_large.png?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
https://help.ascendertx.com/test/business/lib/exe/detail.php/images/picklist_large.png?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
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Select Extra Duty Codes or
blank for ALL

Select all of the supplements as only those supplements that
are tied to an employee being moved based on the first pay
date code will be selected. You can select a supplement even
if it is tied to an employee who you do not want to pay yet.
Type the extra duty codes, separating multiple extra duty
codes with a comma but no space (e.g., 08,20,A2,TF). Or, click

 to search for extra duty codes. Otherwise, leave blank to
use all extra duty codes.

Select Positions or blank for
ALL (Includes ALL billets for
selected positions Blank for
ALL not processed when
Positions/Billets selected)

Type the position codes, separating multiple position codes
with a comma but no space (e.g., PRIN,T187). Or, click  to
search for position codes. Otherwise, leave blank to use all
position codes.

Select Positions/Billets or
blank for ALL

Type the position/billet codes, separating multiple
position/billet codes with a comma but no space (e.g.,
PRIN/00001,PRIN/00006). Or, click  to search for
position/billet codes. Otherwise, leave blank to use all
position/billet codes.

Select Supplement Positions
or blank for ALL (Includes
ALL billets for selected
supplement positions Blank
for ALL not processed when
Supplements/Billets
selected)

Type the supplement position codes, separating multiple
supplement position codes with a comma but no space (e.g.,
PRIN,T187). Or, click  to search for supplement position
codes. Otherwise, leave blank to use all supplement position
codes.

Select Supplement
Positions/Billets or blank for
ALL

Type the supplement position/billet codes, separating multiple
supplement position/billet codes with a comma but no space
(e.g., PRIN/00001,PRIN/00006 ). Or, click  to search for
supplement position/billet codes. Otherwise, leave blank to
use all supplement position/billet codes.

Clear Job Years Select to reset the job years to the default value (blank) on
the employee's job record.

If not selected and the employee's forecast position job code
is the same as the current year job master record, then the
new job record is populated with the values from the current
year job master record.

Clear Job Weekly Hours
Scheduled

Select to reset the weekly hours scheduled to the default
value (blank) on the employee's job record.

If not selected and the employee's forecast position job code
is the same as the current year job master record, then the
new job record is populated with the values from the current
year job master record.

❏ Click Execute to execute the process. The following reports are available:

https://help.ascendertx.com/test/business/lib/exe/detail.php/images/picklist_large.png?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
https://help.ascendertx.com/test/business/lib/exe/detail.php/images/picklist_large.png?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
https://help.ascendertx.com/test/business/lib/exe/detail.php/images/picklist_large.png?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
https://help.ascendertx.com/test/business/lib/exe/detail.php/images/picklist_large.png?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
https://help.ascendertx.com/test/business/lib/exe/detail.php/images/picklist_large.png?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
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Move Forecast Process Error Listing Important errors
Error Message Description
Warning: The employee has
Contract Balance amounts not
equal to zero for current jobs.

The employee has not been paid off by payroll.

Failure: Position Accept
Changes Flag set to Y The position will not be moved to the current/payroll.

Failure: Emp Nbr must have
one position declared as
primary.

The error does not necessarily reference the Primary
Job field on the position. If an employee has a regular
position and a supplement position, but there is an
error that causes the primary position to fail, this
message often indicates that there is only a
supplement position to be moved. It is recommended
to review and correct any errors that begin below this
message about primary positions. After making those
corrections, run the process again. This may resolve
the primary job errors.

This error also occurs when calendars have not been
copied to the current year.

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_moveforecasttocyrpositionandpayroll_processingreports.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
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Error Message Description
Warning: Emp Nbr has
multiple supplement positions
for the same job; however,
one or more of the following
do not match: Campus ID,
Dept, TRS Status Code, FTE
Units, Incr Elig, Max Paymts,
FICA Elig, Unemp Elig, EEOC,
Workers Comp, Supplement
Extra Days or Category Cd.
The values from lowest
Supplement Position
Number/Billet may be used if
new rows are inserted for the
Pay Info and Job Info tabs.

This error indicates that the fields on the Payroll >
Tables > Salaries > Extra Duty tab do not match
those selected on a supplemental position.

Use the Position Management > Inquiry > PMIS Staff
Inquiry to determine the Position Number and Billet
for any supplemental positions for the employee.
Then, use the Position Management > Maintenance >
PMIS Supplement Modify page to retrieve the position
and billet and compare the fields on the position to
the Payroll > Tables > Salary > Extra Duty tab for the
extra duty number on the supplement. For example,
in some cases the W/C code on the position may not
match the W/C code on the table. Or, the Exp 373
field on the position may be selected, but the Exp
373 on the table for that extra duty code may not be
selected. Either the table or the position needs to be
updated so that they both match. If changes are
made to the Extra Duty table, it is necessary to move
the table to the current year payroll before
proceeding.

Update CYR Positions From Forecast - The error report lists any funds that need to be set
up in the Finance tables.

Update CYR Payroll From Forecast by Employee Name

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_moveforecasttocyrpositionandpayroll_errorreport.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_updatecyrpositionsfromforecast.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
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Update CYR Payroll From Forecast by Campus ID

❏ Click Generate Reports. The selected reports are displayed. Review the report.

❏ Click Continue to view the next report. Or, click Return to return to the report selection
page.

❏ After reviewing all of the reports and correcting all errors, return to the report selection
page and click Process to move the forecast records to the current year. You are prompted
to create a backup.

After the process is completed, the actual update is performed. If the update is
successful, a message is displayed indicating that the move forecast updates were
processed successfully.

Reminder: If fund/fiscal year(s) were added to Finance based on the error report listing,
they should be deleted at this point.

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_updatecurypayrollfromforecastbyempname.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_updatecyrpayrollfromforecastbycampusid.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
https://help.ascendertx.com/test/business/doku.php/general/printreport
https://help.ascendertx.com/test/business/doku.php/general/pmis_updatesalarytables_backup
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❏ Click Cancel to return to the Move Forecast to CYR Position and Payroll page without
moving the forecast records to the current year.

If corrections are processed, repeat this step.

Generate and save each report. Compare the Update CYR Positions From Forecast report to
the user-created report that was previously generated to confirm that all 12-month
employees are included. The last two reports contain the same information; one is sorted by
employee name and the other by campus ID. These reports reflect the existing salary in the
current year payroll and the new salary, which overwrites the current year payroll amounts.
Review the reports for accuracy.

Confirm that CYR salaries are accurate.9.

Log on to the current year.

Verify the current year data to confirm that the salaries are correct. The following fields are
updated:

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_employmentinfoverifycyrsalaries.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
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https://help.ascendertx.com/test/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_payinfo.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll


Business

2026/03/21 07:24 16 ASCENDER - Position Management: Update NYR Positions and Move Employees to CYR Payroll

https://help.ascendertx.com/test/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_jobinfo.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
https://help.ascendertx.com/test/business/lib/exe/detail.php/general/updatenyrpositionsmoveemployeestocyr_distributions.jpg?id=academy%3Abusiness_positionmanagement_updatenyrpositionsandmoveemployeestocyrpayroll
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Mass update fiscal year.10.

Log on to the current year.

Payroll > Utilities > Mass Update > Employee

Skip this step if your LEA has a 7/1 fiscal year.

Mass update the fiscal year to the current school year for all employees.

Select Fiscal Year and type the current year fiscal year. Before processing, stop to consider if
the LEA uses other fiscal years in the account codes for employees. If the entered year is not
the only used fiscal year, additional parameters may need to be selected.

Contact your regional ESC consultant if you need assistance.

Identify those employees with a June payoff date and mass update the Hrs Per Day field.

For LEAs that use the hours per day functionality in the current year payroll, select the
Hrs Per Day field and type the number of hours per day for the majority of employees.
Use the parameters to select specific groups of employees for the update.

11-month Employees

10-month Employees

https://help.ascendertx.com/test/business/doku.php/payroll/utilities/massupdate/employee
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